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SUMMARY
The paper is aimed at generating optimal swing motions
during the single-support phase of sagittal gait. Unlike the
previous Part 1 which deals with passive motions, all joints
of the biped are assumed to be active in the present Part 2.
The final conditions specify an impactless heel-touch in
order to avoid a destabilizing effect on the biped motion. As
the biped is essentially submitted to gravity forces, the
motion is generated by minimizing the joint actuating
torques. Feasible motions are defined by state inequality
constraints limiting joint motions, and defining foot clear-
ance and obstacle avoidance during the swing. The
optimization problem is dealt with using Pontryagin’s
Maximum Principle. A final two-point boundary value
problem is solved by implementing a shooting method. The
approach presented is illustrated by various numerical
simulations applying to a seven-body planar biped which
has four or five active joints during the swing phase.

KEYWORDS: Sagittal gait; Single support phase; Bipedal robot;
Dynamics of walking; Motion optimization; Obstacle avoidance.

1. INTRODUCTION
In the field of biped locomotion, our reference model is
human gait. Although the kinematics organization of human
walking is quite easy to describe, the underlying dynamics
is complex to analyze and even more difficult to simulate.
On the other hand, if we want to move a legged-robot, a
simple means to define its gait consists in introducing a
kinematic model of walk. But, even though such a model
would seem to be well organized, it would not ensure the
quality of its dynamics, that is to say, a good synchroniza-
tion together with restrained values of joint actuating
torques, as well as moderate energy consumption. This is a
major reason to search for an organizing principle of the
dynamics of biped locomotion, able to generate reference
steps. Such an objective is pursued in many works dealing
with gait dynamics with an optimization aspect.

The prevailing idea is based on the minimization of a
performance criterion with a dynamic content involving
essentially the joint actuating torques, or the energy
consumption. An interesting first attempt to generate an
optimal step is extensively developed in reference [1]. The

problem is stated using a simplified dynamic model of the
biped moving in the sagittal plane. The hip trajectory is
prescribed during the whole gait cycle, while the ankle
trajectory is only specified during the swing phase. Thus,
the optimal motion generated comprises only two degrees of
freedom, which is quite restrictive. In fact, the main interest
of this work is the approach presented to deal with the
optimization problem, which is stated within the frame of
the optimal control theory. Accordingly, the implemented
optimization technique is the Pontryagin Maximum Princi-
ple (PMP). Kinematic constraints are taken into account by
means of an augmented integral criterion, and are dealt with
using a penalty method. In this way, the constrained
optimization problem is transformed into a sequence of
unconstrained problems which are solved as two-point
boundary value problems. We use a similar approach in our
paper, but on the basis of a global dynamic model of the
biped.

Hatze2 applies the PMP to generate an optimal dynamic
behaviour of a musculo-skeletal model of a human locomo-
tion limb. The performance index is the minimum time
required to transfer the mechanical system from a given
initial position to a specified final position. The author
concludes that another relevant criterion to be minimized
would be the total energy expended by muscles during the
motion. Still for the case of human gait, Bourassa et al.,3

make a different choice by introducing the minimization of
muscular efforts. Three characteristic phases of gait (pos-
ture, deployment and swinging) are studied by introducing
a set of suitable constraints. The movement of the hip is
prescribed, and the trunk motion can be dealt with
separately.

Another approach to gait optimization consists in using
parameterization techniques.4–9 Parameterizing a motion
means that it is partly defined by means of explicit but
incompletely specified time functions. Using this approach,
the optimization problem is drastically simplified. In fact, it
can be reduced to the minimization of an algebraic function
depending on a finite number of discrete unknown variables.
The final problem may be solved using different techniques,
the prevalent one being sequential quadratic programming.
Two different approaches are used to partly specify the
biped movement. In references [4, 6] this motion is
described in the operational space by representing the hip
trajectory together with the ankle trajectory of the swing
foot. As in references [5, 7–9] the alternative approach
consists in representing directly the joint coordinates. In

* Part 1 appeared in the previous issue of Robotica (Vol. 19, Part
2, pp. 163–176).

Robotica (2001) volume 19, pp. 241–253. Printed in the United Kingdom © 2001 Cambridge University Press

https://doi.org/10.1017/S0263574700003039 Published online by Cambridge University Press

Distiller Job Options
DistillerNotes.ps V1.01E ©1998 PrePress-Consulting, Switzerland & Lupin Software, USA
Latest version: http://www.prepress.ch, Info: sjaeggi@prepress.ch / info@lupinsw.com
====================================================================
This note should be viewed with Helvetica and a point size of 10 points.
You can print this information using Tools>Summarize Notes and File>Print... 

__/ GENERAL\________________________________________________________
FILE SETTINGS
    Compatibility = Acrobat 3.0
    ASCII Format = Off
DEVICE SETTINGS
    Current Resolution = 600 x 600 dpi
    Current Page Size = 595 x 842 points / 8.26 x 11.69 inch / 20.99 x 29.7 cm
    (The above settings are the actual values in use, NOT the entries in Distiller options!)

__/ COMPRESSION \___________________________________________________
    Compress Text and Line Art = On
COLOR BITMAP IMAGES
    Sampling = Average to 120 dpi
    Automatic Compression: ZIP/JPEG Medium
GRAYSCALE BITMAP IMAGES
    Sampling = Average to 120 dpi
    Automatic Compression: ZIP/JPEG Medium
MONOCHROME BITMAP IMAGES
    Sampling = Average to 300 dpi
    Manual Compression: ZIP

__/ FONT EMBEDDING \________________________________________________
    Embed All Fonts = On
    Subset Fonts = On below 99 %
    Always Embed List: 
    Never Embed List: 

__/ ADVANCED \______________________________________________________
    prologue.ps / epilogue.ps = Not Used
    Convert CMYK Images to RGB = On
    Preserve OPI Comments = On
    Preserve Overprint settings = On
    Preserve Halftone Screen Information = On
    Transfer Functions = Preserve
    Undercover Removal / Black Generation = Preserve
    Color Conversion = Unchanged
____________________________________________________________________
ADDITIONAL INFORMATION
    Distiller Version = 3.02 / Unix
    ImageMemory = 524288
    AutoRotatePages = PageByPage
    UseFlateCompression = On
    ConvertImagesToIndexed = On
    ColorImageDepth = Unchanged
    AntiAliasColorImages = On
    GrayImageDepth = Unchanged
    AntiAliasGrayImages = On
    MonoImageDepth = Unchanged
    AntiAliasMonoImages = On
____________________________________________________________________

DISCLAIMER

NO software is free of all errors. We have extensively tested DistillerTools and have 
made every attempt to make our tools compatible with all platforms supported by 
Acrobat Distiller. Because our PostScript programs are loaded at the time Distiller 
starts up, we have to work on top of your PostScript programs which are generated by 
a wide variety of applications and printer drivers from different platforms. If you 
encounter an error after you have loaded our tools, do not panic! Just remove the tool 
from the startup directory and restart Distiller. You will be fine. If errors occur please 
go to our bug report page at http://www.prepress.ch/e/pdf/distillertools/bug-report.html 
and report your problem using the form on our website.  DO NOT SEND HUGE 
POSTSCRIPT FILES, just send us the log file created by Distiller! We will 
contact you if we need the PS file to fix the error. We hope that you understand 
that we can not provide any phone support for these tools. Thank you very much for 
your cooperation!


DISTRIBUTION

We give you the right to distribute the demo version (without the registration key) 
to your friends and customers on an individual basis. If you want to distribute 
our tools on a CD-ROM or put them on your web site or BBS, please contact us first.


CUSTOMIZED VERSIONS

For a small fee you can get customized versions of DistillerTools with your own text in the 
notes and reports (e.g. special instructions for your customers) and your messages in 
the Distiller window. A great marketing tool! Contact us for a quote.


SPECIAL THANKS

We would like to thank all of our friends who helped testing these tools. 
Special thanks go to Helge Blischke from SRZ in Berlin for his incredible help, 
Gary Cosimini from Adobe Systems in New York for the idea of FontNotes, and 
Frank Wipperfürth of CTP Service in Germany for finding most of the bugs!


MORE INFORMATION

For additional information please contact sjaeggi@prepress.ch or info@lupinsw.com.

Fonts used in this document
FontNotes V1.01 ©1998 Lupin Software, USA & PrePress-Consulting, Switzerland
Latest version: http://www.prepress.ch, Info: info@lupinsw.com / sjaeggi@prepress.ch
====================================================================
This note should be viewed with Helvetica and a point size of 10 points.
You can print this information using Tools>Summarize Notes and File>Print... 

The following fonts were AVAILABLE during distilling: 
    Courier       (Core Font ***)
    MathematicalPi-Two       (PostScript Font - Type 1)
    Times-Italic       (PostScript Font - Type 1)
    MathematicalPi-Four       (PostScript Font - Type 1)
    LucidaMath-Symbol       (PostScript Font - Type 1)
    MathsTimesPlain       (PostScript Font - Type 1)
    Times-Bold       (Core Font ***)
    MathematicalPi-Three       (PostScript Font - Type 1)
    MathematicalPi-Five       (PostScript Font - Type 1)
    Times-Roman       (Core Font ***)
    MathematicalPi-One       (PostScript Font - Type 1)
    MathsPi-ItPlain       (PostScript Font - Type 1)
    Symbol       (Core Font ***)

*** Attention: Core Fonts are never embedded!


__/ DISTILLER FONT SETTINGS \________________________________________
    Embed All Fonts = On
    Subset Fonts = On below 99 %
    Always Embed List: 
    Never Embed List: 
____________________________________________________________________
!!! To avoid font substitution you should remove the 
!!! font database "superatm.db" in the Fonts directory.

Sometimes applications are calling certain fonts (e.g. Courier, Symbol)
by default even if they might not be used in the document!
____________________________________________________________________

DISCLAIMER

NO software is free of all errors. We have extensively tested DistillerTools and have 
made every attempt to make our tools compatible with all platforms supported by 
Acrobat Distiller. Because our PostScript programs are loaded at the time Distiller 
starts up, we have to work on top of your PostScript programs which are generated by 
a wide variety of applications and printer drivers from different platforms. If you 
encounter an error after you have loaded our tools, do not panic! Just remove the tool 
from the startup directory and restart Distiller. You will be fine. If errors occur please 
go to our bug report page at http://www.prepress.ch/e/pdf/distillertools/bug-report.html 
and report your problem using the form on our website.  DO NOT SEND HUGE 
POSTSCRIPT FILES, just send us the log file created by Distiller! We will 
contact you if we need the PS file to fix the error. We hope that you understand 
that we can not provide any phone support for these tools. Thank you very much for 
your cooperation!

DISCLAIMER

NO software is free of all errors. We have extensively tested DistillerTools and have 
made every attempt to make our tools compatible with all platforms supported by 
Acrobat Distiller. Because our PostScript programs are loaded at the time Distiller 
starts up, we have to work on top of your PostScript programs which are generated by 
a wide variety of applications and printer drivers from different platforms. If you 
encounter an error after you have loaded our tools, do not panic! Just remove the tool 
from the startup directory and restart Distiller. You will be fine. If errors occur please 
go to our bug report page at http://www.prepress.ch/e/pdf/distillertools/bug-report.html 
and report your problem using the form on our website.  DO NOT SEND HUGE 
POSTSCRIPT FILES, just send us the log file created by Distiller! We will 
contact you if we need the PS file to fix the error. We hope that you understand 
that we can not provide any phone support for these tools. Thank you very much for 
your cooperation!


DISTRIBUTION

We give you the right to distribute the demo version (without the registration key) 
to your friends and customers on an individual basis. If you want to distribute 
our tools on a CD-ROM or put them on your web site or BBS, please contact us first.


CUSTOMIZED VERSIONS

For a small fee you can get customized versions of DistillerTools with your own text in the 
notes and reports (e.g. special instructions for your customers) and your messages in 
the Distiller window. A great marketing tool! Contact us for a quote.


SPECIAL THANKS

We would like to thank all of our friends who helped testing these tools. 
Special thanks go to Helge Blischke from SRZ in Berlin for his incredible help, 
Gary Cosimini from Adobe Systems in New York for the idea of FontNotes, and 
Frank Wipperfürth of CTP Service in Germany for finding most of the bugs!


MORE INFORMATION

For additional information please contact sjaeggi@prepress.ch or info@lupinsw.com.

https://doi.org/10.1017/S0263574700003039


both cases, the time functions used are polynomials or finite
Fourier series. The problem unknowns are simply the
coefficients of these functions. In reference [8] a 6-body
biped without a trunk is studied, while in other papers,
5-body bipeds are modeled. The performance criterion to be
minimized represents an energetic cost as in references
[4–8], or the integral quadratic norm of joint actuating
torques.7–9 In most cases, the kinematic model of gait
comprises an instantaneous double support phase with
impact at heel-touch. In other respects, inequality con-
straints expressing the unilaterality of contact with the
ground are verified a posteriori. Parameterization tech-
niques yield sub-optimal solutions.

Another interesting contributing to human gait optimiza-
tion is found in reference [10]. The authors compare the
optimal motions generated by seven different performance
criterions. They conclude that the optimizing index which is
suited at best to human gait is the minimization of joint
actuating torques.

Let us mention that many bipedal walking machines have
been designed during the last two decades. The reader is
especially referred to references [11–15] describing biped
robots that have walked. Suitable control techniques must
be developed to produce efficient walk with a moderate
dynamic cost. In reference [11], the authors emphasize the
fact that a preliminary problem consists in selecting good
trajectories. This concern reappears in references [14, 15]
where the local controller controls joint actuators in order
for the robot to follow preset walking patterns. Thus,
generating reference gait patterns in the context of motion
control is a relevant means for mastering the biped
dynamics, especially for the case when the inertia and mass
of the legs are sizeable, and when the biped does not walk
at a slow pace.

In the present paper, motions to be generated do not
depend on any preliminary kinematic representation. The
minimization of an integral cost yields directly an optimal
step satisfying constraints which define feasible motions. As
in most of papers above mentioned, our study is focused on
the swing phase of sagittal gait. We consider a 7-body
planar biped with a trunk and anthropomorphic feet. Due to
the fact that the biped is essentially submitted to gravity
forces, we have favored the minimization of joint actuating
torques instead of energy expenditure. Moreover, as Blajer
and Schiehlen16 did for motion control of a biped, we invoke
the destabilizing effect of impact at heel-touch to motivate
the search for an impactless gait at the end of the single-
support phase. Feasible motions are defined by state
constraints limiting the joint movements, and preventing
foot collision with the ground or an obstacle.

The optimization problem, and particularly the dynamic
model of the biped are especially formulated for applying
the Pontryagin Maximum Principle. An efficient imple-
mentation of this powerful mathematical tool requires to
have recourse to Hamiltonian formalism. This formulation
is presented in the second section of the paper. In the third
section we detail the constraints which define feasible
motions. The fourth section is devoted to the formulation of
an optimal control problem together with the necessary
conditions of optimality stated by the PMP. We present a

variety of numerical simulations in the fifth section. We
present conclusions in section six, and indicate perspectives
for developing the approach presented.

2. KINEMATICS AND DYNAMICS OF A PLANAR
BIPED
The planar multibody system which models the biped is
similar to the reference model used in the companion paper
(Part 1). But, in the present case, more free joints are
considered, and all of them are powered. A complete
Hamiltonian dynamic model is formulated on the basis of a
set of relative joint coordinates.

2.1 Kinematic model
We describe a sagittal model of an anthropomorphic biped.
Figure 1 shows the diagram of the biped at initial time (toe-
off) and final time (heel-touch) of the swing phase.

This model is made up of 7 limbs numbered from L0 to
L6. The three first links (L0 to L2) represent the foot, the shin
and the thigh of the stance leg. The next one L3 is the trunk,
while L4 to L6 stand for the thigh, the shin and the foot of the
swing leg. Such a planar system comprises six joints: two
ankles, two knees and two coaxial hip joints. This model
makes it possible to simulate the human gait in the sagittal
plane when the sway motion (frontal rotation of the pelvis)
is not very important. As we assume that the stance foot
remains motionless and flat on the ground during all the
swing phase, the biped motion can be described by the six
relative joint coordinates we define as:

qi = (Xi, Xi21)Z0
, i = 1, . . . , 6 (Z0 = X03 Y0) (1)

Let us add the complementary notations

Fig. 1. 7-link planar biped at toe-off and heel-touch.
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q = (q1, . . . , q6)T, vector of joint coordinates
q̇ = (q̇1, . . . , q̇6)T, vector of joint velocities
q̈ = (q̈1, . . . , q̈6)T, vector of joint accelerations

where q̇i = dqi /dt, q̈i = d 2qi /dt 2.
In accordance with the schematic representation in Figure

1, we define the dimension and inertia characteristics of the
biped as

Oi Oi +1 = ri Xi, i = 1, . . . , 5 ; ri , length of link Li

Oi Gi = ai Xi; Gi, center of inertia of link Li, i = 1,
. . . , 5

O6G6 = a6X6 + b6Y6, (Y6 = Z0∧X6)
mi , mass of Li

Izz
i , moment of inertia of Li with respect to the

joint axis (Oi; Z0)

Numerical values of these dimensional parameters are given
in the appendix.

In order to master progressively the computational
processing of the optimization problem stated in the next
section, we will use initially a simplified 4-dof model with
q2 = cste and q6 = cste (the knee of the stance leg together
with the ankle of the swing leg are locked). Afterwards, by
means of these first results, we shall be able to deal with
models with extended kinematics.

2.2 Dynamic model
As a preliminary remark, let us underline that it may be
computationally quite efficient to formulate a dynamic
model adapted at best to the chosen optimization technique.
As we intend to use the Pontryagin Maximum Principle (or
PMP) for solving the dynamic optimization problem stated
in what follows, let us recall that the implementation of the
PMP requires the formulation of the dynamic model in state
space form. As indicated in references [17, 18] the
Hamiltonian dynamic model not only best fulfills this
requirement but, as well, strengthens the robustness of
algorithms used to solve the optimization problem. We
present the outlines of the formulation we need.

Firstly, introducing the Langrangian of the mechanical
system

L(q, q̇) = T(q, q̇)2V(q) (2)

where V stands for the gravity potential, and T is the kinetic
energy defined as

T(q, q̇) = 1/2q̇, q̇T M(q)q̇ , (3)

M being the (n3 n) mass matrix of the kinematic chain,
Lagrange’s equations of motion may be derived as

d
dt S ­L

­q̇i
D2

­L
­qi

= Qd
i + Qa

i , i = 1, . . . , n , (4)

where Qa
i (resp. Qd

i ) represents the joint actuating torque
(resp. joint dissipative torque) exerted by Li–1 on Li at Oi (cf.
Figure 1).

Secondly, defining the conjugate momenta

pi =
­L
­q̇i

, i = 1, . . . , n , (5)

and the Hamiltonian

H(q, p) = pTq̇2L(q, q̇) , with p = (p1, . . . , pn )T (6)

Lagrange’s equations in (4) may be reformulated in
Hamiltonian form

H q̇i = ­H
­pi

ṗi = 2
­H
­qi

+ Qi
a + Qi

d (7)

Now, considering (2) and (3), the expression of p can be
written through (5) as

p = Mq̇

or, inversely

q̇ = M21p

Using these expressions in (3) and (6), one obtains:

H(p, q) =
1
2

pT M21p + V

Then, (7) becomes more explicitly

q̇i = Gi (q, p) ; On
j = 1 M 21

i j pj

ṗi = 2
1
2 pT M21

,i p2V,i + Q a
i + Q d

i

(8)

where M21
,i ; ­M21/­qi, V,i ;­V/­qi.

In (8) the presence of the derived matrices M21
,i makes

this formulation impracticable. But, defining the vector
G = (G1, . . . , Gn)T (see (8)) and using the formula
(M21),i = –M–1 M,i M

–1, the set of equations (8) can be
reformulated on the basis of the derived matrices M,i
(instead of M21

,i in (8)) as

H q̇i = Gi (q, p)

ṗi = 1
2 GT M,i G2V,i + Q i

a + Q i
d (9)

With this formulation,17 Hamiltonian equations are ideally
structured for applying the Pontryagin Maximum Principle.

Now, defining

i ≤ n
xi = qi

xn +i = pi

ui = Q i
a

x = (x1, . . . , x2n)T, vector of state variables
u = (u1, . . . , un)T, vector of control inputs (joint actuating

torques)

Fi ; Gi = On

j = 1 M21
i j xn + j

G = (G1, . . . , Gn)T

Fn + i = 1/2GT M,i G2V,i + Qi
d

F = (F1, . . . , F2n)T ,

the double set of vectorial equations (7) can be recast as the
2n-order differential vector-equation:

Sagittal gait (2) 243
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ẋ(t) = F (x(t)) + Bu(t) ; F(x(t), u(t)) (10)

where F is a nonlinear function in x, and B is the constant
(2n3 n) matrix such as

B = F B1

B2
G , B1 = 0n3 n , B2 = In3 n (11)

In this equation, initial and final states will be specified as

k ≤ n ,

xk(t
i ) = qi

k , xk(t
f ) = q f

k

ẋk(t
i) = pk(t

i) = Oj ≤ n Mk j(q
i)q̇i

j

ẋk (t f ) = pk(t
f ) = Oj ≤ n Mk j(q

f )q̇ f
j

(12)

where it will be assumed in subsection 3 that initial and final
Langrangian phase-variables qi

k, q̇
i
k, q

f
k, q̇

f
k,  have specified

values. Consequently, initial and final Hamiltonian states
x(t i ) and x(t f ) will be entirely specified as well.

Let us mention that a complementary transformation
remains to be achieved in order to perfect formulation (9,
10, 12). It consists in rescaling all the variables of the
problem to homogenize their order of magnitude. To that
end, one can introduce the following reference quantities: L̄,
M̄, T̄, Ī, Q̄, respectively length, mass, time, moment of
inertia and torque of reference which can be defined and
linked as

M̄ = 1
n (m1 + . . . + mn )

Q̄ = 1
n (Q a,max

1 + . . . + Q a,max
n )

Ī = M̄ L̄2 , T̄ = Ï Ī
Q̄

(13)

where mi is the mass of link Li, and Qa,max
i is the maximal

value of uQ a
i u.

Also, let t be the reduced time t = t
T̄. Then, we define

adimensional state variables xj as

i ≤ n , H xi (t) = qi (t)
xn+i (t) = pi (t) / M̄ L̄2 T̄ 21 ,

(14)

together with normalized actuating torques

ui (t) = Q a
i (t) /Q a,max

i ; Q a
i (t) /ni Q̄ , (15)

where ni stands for the adimensional coefficient ni = Q a,max
i /

Q̄.
With these new variables, equation (10) remains formally

unchanged, except that the matrix B2 becomes B2 = diag(n1,
. . . , nn).

3. FEASIBLE MOTIONS AND CONSTRAINTS
Feasible motions of the biped are defined by two types of
specific conditions: The first type consists of state con-
straints involving the phase coordinates qi, q̇i (i ≤ n) through
the state variables xj ( j ≤ 2n). The second type specifies
interaction conditions between the stance foot and the
ground.

3.1 State constraints
Such constraints may be instantaneous when considering
conditions imposed at toe-off and heel-touch, or permanent
when they must be fulfilled during the whole interval of
time.

3.1.1 Initial and final constraints. As in the companion
paper these constraints specify the conditions of toeing-off
and heel-touch at start and end of the swing motion.

Initial conditions are primarily formulated as vectorial
projections

ODi · X0 + L = 0 ,
ODi · Y0 = 0 ,
V(Di ) · X0 = 0 ,
V(Di) · Y0 = 0 ,

(16)

the two first relationships indicating that the foot tip is in
contact with the ground at the right place, the two next ones
expressing that the same point C i (Figure 1) has no initial
velocity at the beginning of the swing motion. But, on the
other hand, the foot may have a rotation velocity about the
point C i at the initial time.

We formulate quite similar conditions at final time

OC f · X0 2 (L2 l) = 0 ,
OC f · Y0 = 0 ,
V(C f ) · X0 = 0 ,
V(C f ) · Y0 = 0 ,

(17)

the two first ones expressing a symmetrical repositioning of
the swing foot on flat ground (l stands for the foot length as
indicated in Figure 1). The last two prescribe an impactless
heel-touch. This is the main difference between conditions
(17) and similar conditions formulated in Part 1 of the
paper; in what follows, zero impact velocity will be exactly
satisfied by any optimal solution while in the previous study
we only tried to reduce the velocity of point C f at heel-
touch.

Constraints (16, 17) can be formally expressed as

k ≤ 4 , H Ci
k (qi, q̇i ) = 0

C f
k (q f, q̇ f ) = 0

(18)

As in reference [19], at both initial and final times we
specify the position of the trunk and assume that its absolute
rotation rate is equal to zero, which implies a relationship

Ok≤3 qi
k = Ok≤3 q f

k = a

Ok≤3 q̇i
k = Ok≤3 q̇ f

k = 0
(19)

where the value of a is either equal or close to p/2.
We define, as well, the joint coordinates and velocities of

the stance leg:

k = 1, 2 , H qk(t
i) = qi

k , q̇k(t
i) = q̇i

k

qk(t
f ) = q f

k , q̇k(t
f ) = q̇ f

k

(20)

where qi
k and q f

k are given, while q̇i
k and q̇ f

k are chosen in
order to respect a given mean-value of the hip velocity.
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Lastly, we specify the ankle coordinates and velocities of
the swing foot:

q6(t i) = qi
6 , q̇6(t

i) = q̇i
6

q6(t
f ) = q f

6 , q̇6(t
f ) = q̇ f

6

(21)

where quantities in right hand members represent given
values.

Then, taking into account data (19), (20) and (21), the
constraints (18) may be solved in order to completely define
initial and final conditions, namely, qi, q̇i, q f, q̇ f.

3.1.2 Bound constraints. In order to respect joint stops, to
prevent counter-flexion and to moderate total joint coor-
dinate variations, we must prescribe bounds on joint
coordinates, defined as the box constraints

t P [ti, t f ], i ≤ n, qmin
i ≤ qi (t) ≤ qmax

i (22)

where qmin
i and qmax

i are specified values.
This set of double inequalities can be recast under the

standard form of 2n simple constraints

Hhi (q(t)) ≤ 0
hn+1(q(t)) ≤ 0

,
,

where

where

hi (q(t)) = qi (t)2qi
max

hn+i (q(t)) = qi
min 2qi (t)

(23)

In fact, the only useful constraints we need in our problem
concern both knee and ankle coordinates of the swing leg.
Other joint coordinates will keep spontaneously appropriate
values.

3.1.3. Foot clearance. During the swing phase, inter-
mediate contact of the foot with the ground must be
prevented. The biped should be able as well to step over
low-sized obstacles. In a general way, biped abilities to clear
an obstacle, to step across a sill and to climb stairs, are many
advantageous intrinsic features of bipedal locomotion.

A simple means to model obstacle avoidance by the
swing foot in the sagittal plane consists in defining a
collision zone surrounding the obstacle. As indicated in
Figure 2, the upper boundary of this area may be
represented by a curve which can be defined by a simple
function. For instance, the 5th degree polynomial

w(x) = a0 + a1(x2d) +a2(x2d)2 + . . . + a5(x2d)5 (24)

may be adjusted so as to go through the points D9, E and C9
with a null slope at these points (Figure. 2). Both points D9
and C9 could also coincide with Di and C f respectively.

The coefficient a0, . . . , a5 must be computed with respect
to the values of parameters c, l and h (see Figure 2) which
are positive constants.

It is obvious that a0 = a1 = 0. Other coefficient can be
expressed using the formula

[a2 a3 a4 a5]T = B21[0 0 h 0]T

where

B =

2l
l2

c2

2c

3l2

l3

c3

3c2

4l3

l4

c4

4c3

5l 4

l5

c5

5c4

In Figure 3, the swing foot passes through a collision zone.
Since the variation of the rotation angle of the foot at

ankle is limited, one can say that the foot avoids the obstacle
if any point of the sole C D (Figure 4) remains outside the
upper boundary of the collision zone. This condition is
expressed as

;t P [0, T], ;P P CD, hP(q(t)) ;w(xP(q(t))2yP(q(t)) ≤ 0

where the function w defines the curve surrounding the
obstacle.

Fig. 2. Collisional zone surrounding an obstacle

Fig. 3. Foot going through a collisional zone.

Fig. 4. Collisional zone delimited by the ground and the dotted
curve.
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In fact, as we expect that the foot motion is smooth, a
limited number of points belonging to the segment C D can
be sufficient to ensure foot clearance. In practice, both end
points C, D and the middle point M are enough to produce
obstacle avoidance.

In this way, the conditions to satisfy are:

;tP [0, T] ,
hC(q(t))
hD(q(t))
hM (q(y))

;
;
;

w (xC(q(t)))2yC(q(t)) ≤ 0
w (xD(q(t)))2yD(q(t)) ≤ 0
w (xM (q(t)))2yM(q(t)) ≤ 0

(25)

3.2 Sthenic constraints
In contrast with state or kinematic constraints, we term
sthenic constraints the inequalities defining limitations on
some forces and torques acting on the mechanical system.

3.2.1. Box constraints. Torques produced by actuators
have limited values. When they are considered at the joint
level, with the notations introduced in subsection 2.2, we
can write

;tP [0, T] , uQa
i (t) u ≤ Qa, max

i

These box constraints allow the set of feasible normalized
control-variables ui shown in (15), to be defined as

U = {(u1, . . . , ui, . . . , un )PRn /ui P [21, 1], i ≤ n} (26)

which is a centered parallelepiped in Rn.

3.2.2. Unilaterality of contact. In the presented models,
we assume that the foot of the stance leg stays motionless
throughout the movement.

The unilaterality of contact is expressed by the fact that
the vertical component of the ground reaction forces must
remain positive during the motion. This condition simply
means that the foot is not stuck on the ground and that the
ground cannot pull but only push the foot.

In order to easily implement this condition, we consider
that the ground reaction forces can be equivalently repre-
sented by two normal forces NA and NB applied at end points
A and B of the foot (see Figure 5), together with a horizontal

force acting on the sole. The latter will not be taken into
consideration in our present problem. This means the
friction coefficient between the sole and the ground is
assumed to have a sufficiently great value to prevent any
sliding of the stance foot.

Noting:

— F, the total force exerted by the ground on the foot,
— T1, the torque exerted about O1 by the foot on the shin,

one obtains the relationships:

NB = 1
l (T1 2FY (l2b)2aFX + cm6 g)

NA = m6 g2FY 2NB

(27)

where FX and FY stand for the component of F with respect
to X0 and Y0 (see Figure 5).

Expressions of these components are found by formulat-
ing Newton’s equation of motion for the whole biped, which
yields

FX = 2O6
i=1 mi $g (Gi ) · $X0

FY = 2O6
i=1 mi $g (Gi ) · $Y0 2O6

i=1 mi g

(28)

With these expressions for FX and FY in (27), the
unilaterality conditions are expressed as

NA > 0 , NB > 0 (29)

In the following, the fulfillment of constraints (29) will be
realized by weakening the stance ankle torque in the
optimization process.

4. FORMULATING AN OPTIMAL CONTROL
PROBLEM
We wish to generate an optimal swing transfer by
minimizing a performance criterion representing a dynamic
cost. Roughly speaking, we have the choice between
minimizing actuating torques as in references [19, 20], or
energy expenditure.21,22 Since the biped stands and moves in
a vertical plane, it is essentially submitted to gravity. For
this reason, we have favored the first choice by introducing
the integral cost

J(u) = E t f

t i L(x(t), u(t))dt (30)

where the Langrangian is the quadratic function of the
normalized control-variables ui

L(x, u) ; 1
2 On

i=1 j in i
2ui

2 (31)

where j i ’s are weighting factors and ni ui ’s represent
adimensional joint actuating torques as defined by (15).

Let us mention that criteria like (30, 31) have been
implemented to optimize the motions of vertical serial
manipulatory arms in references [18, 23]. But, we shall use
this cost in a somewhat different way due to the fact that the
weighting coefficent can play a much more useful role in the
problem we are stating. At first, let us point out that when j i

increases, the optimal corresponding ui is lowered. We will
make use of this possibility to reduce the action of both
ankle torques in order, firstly, to avoid an optimal motion ofFig. 5. Forces applied on the stance foot.
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the swing foot with a too large amplitude, and secondly, to
fulfill indirectly the unilateral constraints (29).

4.1 Dealing with the state inequality constraints
Such constraints defined in subsection 3.1 can be easily
dealt with using computing techniques similar to the penalty
method developed in the frame of mathematical program-
ming.24 We have chosen to implement an exact penalty
method defined by introducing the positive functions

i ≤ Nh , h+
i (x(t)) = max(0, hi (x(t)) + bi ) , bi ≥ 0

where each positive constant bi defines an augmented
constraint. This penalty technique consists in minimizing h+

i

functions when the constraint is infringed, in order to bring
hi functions back to zero. This operation is carried out by
minimizing the augmented criterion

Jr (u) = J(u) + r
2 E t f

ti h+ (x(t))T Dhh+ (x(t))dt , r > 0 (32)

where h+ = (h+
1 , . . . , h+

N h
)T, and Dh = diag(z1, . . . , zN h

) is a
weighting matrix.

The functional Jr must be minimized with sufficiently
great value of the penalty multiplier r. But, for increasing
values of r the numerical conditioning of the optimization
problem deteriorates. A simple means to avoid a too great
value of r consists in choosing not too small values for the
bi’s.

4.2 Applying Pontryagin’s Maximum Principle
At this point, the minimization problem may be summarized
as: find a phase trajectory t→x(t), and a control vector
t→u(t) minimizing Jr, namely

min Jr (u),
uPU
r great

(33)

and satisfying the state equation

tP [ti, t f ] , ẋ(t) = F(x(t)) + Bu(t) (34)

together with the end conditions

x(ti) = x i , x(t f ) = x f (35)

where, in (34), x(t) P R2n, and u(t) P Rn.

Defining the Pontryagin function

w P R2n , H (x, u, w) = wT(F(x) + Bu)2L(x, u) , (36)

the maximum principle25 states that if t → (x(t), u(t)) is a
solution of (33–35), then there exists a costate function
t → w(t), w(t) P R2n, satisfying the costate equation

ẇ(t)T =2­H /­x , (37)

and the maximality condition

H (x(t), u(t), w(t)) = max
vPU

H (x(t), v, w(t)) (38)

A prominent interest of the PMP lies in condition (38)
which allows the constraints on u to be exactly satisfied, and
yields through (31), (34) and (36) an explicit expression of
the optimal control under the form of the saturation
function25

i ≤ n , ui(t) = SatFwn+i(t)
j i ni

G , (39)

defined here, as

Sat(x) = H x
xmax sign(x)

if

if

ux u ≤ 1
ux u > 1

Substituting the expression (39) for u in (34), (37), the
unknown functions x and w appear as a solution of a 4n-
order differential system of the type

tP [ti, t f ] , H ẋ(t) = F1(x(t), w(t))
ẇ(t) = F2(x(t), w(t))

(40)

Accompanied by the boundary conditions (35).
Typically, we are in the presence of a two-point boundary

value problem.

5. NUMERICAL SIMULATIONS
The two-point boundary value problem (40, 35) can be
solved using computing techniques such as finite difference
algorithms or shooting methods. We have chosen the latter
approach for its efficiency, and the simplicity of its
implementation. The technique we use is described in
reference [26] as the so-called transition matrix method.
Due to the strong non-linearity of equations (40), the main
difficulty to overcome in order for the algorithm to converge
towards an optimal solution, consists in finding a suf-
ficiently accurate guess solution. This preliminary problem
has been dealt with by solving directly the two-point
boundary value problem when considering a very short
walk-step: about ten centimeters. Then, the optimization
problem can be solved iteratively for increasing boundary
values, until the desired final values are reached. In the same
way, any optimal solution can be used as a guess solution to
solve swiftly a problem related to the previous one.

The biped data is given in the appendix. A detailed
description of the biped technical characteristics can be
found in references [27, 28].

5.1 Optimal motions of a 4-dof biped
We assume that the knee of the stance leg and the ankle of
the swing leg are locked during the single support phase. Let
us mention that gait with stiff stance leg corresponds to
comfortable human walking during which the ankle rotation
of the swing foot is quite small.

Thus, in accordance with Figure 1, we have

q2 = 0 , q6 = b

where b is a given constant value. Other joint coordinates
are free. Therefore, we must define the following initial and
final values of phase coordinates

qi
j, q̇i

j, q f
j, q̇ f

j, for j = 1, 3, 4, 5

which have to satisfy the twelve relationships (18) and
(19).

We have chosen qi
1, q̇i

1, q f
1, q̇ f

1,  as given independent
values which must be fixed in a coherent way.
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Let us add that additional data is the motion time T
together with the step length L. A mean walk-speed noted ȳ
results from the above choices.

For each simulated motion, we present the chosen
numerical values of q̇i

1, q̇
f
1, L, T, ȳ and P% which represents

the percentage of the Single Support Phase (SSP) versus the
whole step.

Energy expenditure is computed using the formula

E = E t f

t i On

i = 1

u q̇i (t)Q
a
i (t) u dt

5.1.1 Step lengthening effect. The swing time T being
fixed, we compare two optimal motions computed with
different step lengths.

Example 1.
The basic data is the step length equal to 0.51 m. Other
characteristic values of the swing motion are given in Table
I.

The optimal motion which is shown in Figure 6 is quite
like human gait. Its average speed is equal to 1.1 m/s (i.e.
about 4 km/h). The energy expenditure amounts to 70.6 J.
We can compare with the result given in reference [6] which
amounts to 75 J for the same speed of gait. But the biped
mass in the latter case is equal to 31 kg versus 87 kg in the
present paper.

The Figures 7 and 8 show the variations of actuating
torques and normal ground reaction forces on the stance
foot. One can notice that the actuating torque at ankle of the
stance leg is positive, i.e. it tends to slow down the motion
in order to ensure heel-touch without impact, as specified by
the final conditions (17). The normal reaction forces remain
positive throughout the motion.

Example 2.
The step length is increased while the transfer time remains
unchanged (see Table II). The average gait speed is equal to
1.44 m/s (about 5.2 km/h) versus 1.1 m/s in the previous
example.

Table I. Characteristic data of the swing motion.

q̇i
1 q̇ f

1 L T ȳ P%
rad/s rad/s m s km/h

21.5 21.5 0.51 0.34 3.97 73

Fig. 6. Optimal gait for a step length equal to 0.51 m. Energy
consumption: E = 70.6 (J).

Fig. 7. Gait at moderate speed. Time variations of actuating
torques.

Fig. 8. Normal reaction forces.

Table II. Motion characteristics.

q̇i
1 q̇ f

1 L T ȳ P%
rad/s rad/s m s km/h

21.95 21.95 0.62 0.34 5.2 79
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The optimal motion shown in Figure 9 looks like the
previous one, but the heel impact is avoided at the expense
of great efforts developed at hip and knee of the swing leg
just before the final time (Figures 10 and 11). The energy
consumption is greatly increased.

5.1.2 Obstacle avoidance and ground clearance. As one
can see in Figure 9, the swing foot only just clears the
ground. We want to examine the ability of our approach to
generate an optimal motion during which the swing foot
gets over an obstacle on the ground. As indicated in
subsection 3.1 we use a 5th degree polynomial function w to
define an anti-collision zone which surmounts the obstacle.
We impose two null minima at points Di and C f, and a

maximum height h = 0.1 m just above the middle point of
the segment DiC f (see Figures 1 and 12). The coefficients of
the function w, as defined in (24), are determined using the
following relations

w(x(Di)) = 0 ,
w(x(C f )) = 0 ,

w(x(Di) + x(Cf)
2 ) = 0.1 ,

ẇ(x(Di)) = 0 ,
ẇ(x(C f )) = 0 ,

ẇ(x(Di)+ x(C f )
2 ) = 0 .

Other basic characteristics of the step are the same as in the
previous example. They are given in Table II.

Figure 12 shows that the collision zone is perfectly
avoided by the swing foot. The gait pattern is not quite
different of the previous one. But the energy consumption is
noticeably increased (140 J versus 121 J).

Fig. 9. Fast optimal gait with a step length equal to 0.62 m.
Energy consumption: E = 121.5 J.

Fig. 10. Fast gait without impact. Time variations of actuating
torques.

Fig. 11. Normal reaction forces.

Fig. 12. Stepping over an obstacle.
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5.1.3 The “heel up” case. As presented in the companion
paper, there are two possible configurations initiating the
swing phase: the configuration “heel down” and the
configuration “heel up”. All the results presented in Part 1 of
the paper have been computed on the basis of “heel down”
initial positions. We present here an optimal motion starting
with a “heel up” position of the swing foot. In this case, as
shown in Part 1 of the paper, the knee has an initial velocity
directed in the opposite direction of gait. This reversed
velocity may produce a counter-flexion of the swing leg at
the beginning of the swing phase. Then, the introduction of
bound constraints as (18), (19) at the knee level is required
to avoid hyper-extension.

Moreover, the respect of unilaterality conditions of
contact makes necessary to weaken significantly the ankle
torque of the stance leg. This can be done by introducing a
sufficiently great value of the weighting factor j1 in formula
(31) in order that the corresponding normalized torque u1

becomes weaker as indicated in section 4.
Computing an optimal motion respecting the previous

constraints is tricky to carry out. The computation was
successful with the data given in Table III.

The optimal motion which appears in Figure 13 shows a
gait pattern quite different from the previous examples. The
swing foot moves simultaneously backwards and upwards
at the beginning of motion. The upward motion is greatly
accentuated. The stance leg is nearly immobilized at mid-
transfer while the trunk gesticulates significantly. The

energy consumption is drastically increased in comparison
with the first examples.

Figures 14 and 15 show that the ankle actuating torque of
the stance leg takes reduced values while the ground
reaction forces remain positive during the whole movement.
All the constraints are effectively respected, but the motion
does not correspond to a natural gait, and is very energy-
consuming.

This result brings out the difficulty in generating a
feasible motion in case of forward flexion of the leg when
there is no ankle at stake. For such locomotion limb with
only two joints at hip and knee, an initial backward flexion
will help to produce a suitable swing motion. But, in this
case, a foot with an appropriate length is required in order
to achieve a proper repositioning at heel-touch.

5.2 Optimal motions of a 5-dof biped
We present two examples: In the first one, the stance leg is
stiff and the ankle joint of the swing leg is active.
Conversely, in the second one, the biped has a flexed stance
leg and its ankle joint is locked.

Table III. Basic data of the motion

q̇i
1 q̇ f

1 L T ȳ P%
rad/s rad/s m s km/h

21.2 21.13 0.41 0.34 2.9 67

Fig. 13. Movement of the biped. Energy consumption: E = 249 J.

Fig. 14. Time variations of actuating torques.

Fig. 15. Normal reaction forces applied to the stance foot.
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5.2.1 Actuating the ankle of the swing leg. Both exam-
ples have the same step length equal to 0.5 m (see Tables IV
and V).

The optimal motion is shown in Figure 16. The rotation
of the foot is noticeably marked. In Figure 18 we can see
that the evolution of reaction forces indicates a transfer of
the weight from heel to forefoot. This forward shift of the
weight is paid by a strongly increasing actuating-torque at
the ankle of the swing leg (Figure 17). This variation can be
interpreted as necessary to ensure the impactless heel-touch
which is specified at final time.

5.2.2 Flexing the stance leg. In this case, we specify the
following initial and final conditions concerning the knee of
the stance leg

qi
2 = 10 (deg) ,

q̇i
2 = 0 (rad/s) ,

q f
2 = 1 (deg) ,

q̇ f
2 = 0 (rad/s) .

Typical features of the motion, given in Table V, are similar
to data of Table IV.

The kinematics pattern of the optimal motion shown in
Figure 19 is fairly like the previous one.

But the motion dynamics is quite different as one can see
in Figures 20 and 21. In fact, the weight transfer does not
occur, and simultaneously the actuating torque at ankle of
the stance leg keeps positive moderate values. Two different
dynamic strategies appear in both optimal motions, and
finally, ensure the same impactless condition at heel-touch.

This dissimilarity between dynamics of both motions is
mainly due to small differences between initial and final
conditions. The result is that the choice of these conditions
has great consequences on the way the motion is organized
and regulated. This choice should be optimized. This is a
perspective in continuing research in the field of optimal
gait.

6. CONCLUSION
The kinematics models we have studied gave us an insight
into the way bipeds can organize and control their motions
during the swing phase.

Table IV. Basic data of the motion

q̇i
1 q̇ f

1 L T ȳ P%
rad/s rad/s m s km/h

21.58 21.62 0.5 0.33 4.42 81

Table V. Basic data of the motion

q̇i
1 q̇ f

1 L T ȳ P%
rad/s rad/s m s km/h

21.6 21.6 0.5 0.32 4.33 77

Fig. 16. Optimal motion with actuated ankle at the swing leg.
Energy consumption: E = 75 J.

Fig. 17. Joint actuating torques evolution.

Fig. 18. Normal reaction forces.
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We examined the optimal swing motions of a 4-dof biped.
In this case, initial forward and backward flexions of the
swing leg produce quite different kinematic and dynamic
characteristics of optimal motions. Initial forward flexion,
corresponding to a “heel-up” position if the shin comprises
a foot, does not allow the biped to generate an adequate
swing. The motion does not appear natural and its dynamics
is not efficient. On the contrary, when the initial flexion is
directed backwards, the propelling effect is appropriate, the
motion is like a human gait, and the energy expenditure is
moderate.

Secondly, we released the ankle joint of the swing foot. In
that case, the optimal motion seems quite natural. In the
same way, the flexion of the stance leg enables the biped to

generate a natural swing which is similar to the previous one
from a kinematic standpoint. We emphasized the dynamic
differences between these two motions, which raised the
problem of their sensitivity to specified end conditions.

On this subject, an improvement of the approach
presented would consist in specifying a minimum of initial
and final constraints in order to deal with a less constrained
problem. It would be possible as well to take into account
the impact velocity at heel-touch. Pontryagin’s maximum
principle seems quite appropriate to deal with an extended
problem of this type.

On the other hand, the double support phase remains to
be dealt with. Since the biped performs as a closed
kinematics chain during a brief lapse of time, a simple
means to tackle this problem may consist in specifying the
kinematics of motion that brings the end of the preceding
unipodal phase to the beginning of the next one. This
approach will result in solving an inverse dynamic problem.
But, for the mechanical system having a closed kinematic
loop, this problem is undetermined. However, it would be
possible to extract a solution of minimal norm in terms of
joint actuating torques and contact forces by using, for
instance, a pseudo-inverse matrix technique as implemented
in reference (29) to solve a cycling problem in the field of
biomechanics. In another respect, the bipodal phase prob-
lem could as well be solved using the maximum principle.

To conclude, a final problem would consist in matching
optimally both phases of gait in order to generate a global
optimal step.
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Appendix
Dimensional characteristics of the biped “BIP”.

Dimensions of links (see Figure 1):

Oj
$Oj + 1 = rj

$Xj , j = 1, . . . , 5

(r1, r2, r3, r4, r5) = (0.4, 0.41, 0, 0.41, 0.4)(m)

Foot dimensions

(O1A, O1B, AB) = (0.12, 0.165, 0.2)(m)

Positions of the centers of gravity:

O$
i Gi = ai

$Xi + bi
$Yi , i = 1, . . . , 6

(a1,a2,a3,a4,a5,a6) = (0.24,0.27,0.33,0.14,0.163,0.004)(m)

(b1,b2,b3,b4,b5,b6) = (0,0,0,0,0,0.08)(m)

Link masses:

(m1,m2,m3,m4,m5,m6) = (6.4,8.6,55.0,8.6,6.4,1.1)(kg)

Moments of inertia of links Li about Oi

(I zz
1 , I zz

2 , I zz
3 , I zz

4 , I zz
5 , I zz

6 )

= (0.44, 0.69, 7.0, 0.23, 0.25, 0.015)(kg.m2)
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